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Welcome to CryptoEdit

Encrypted RTF Documents with Images

CryptoEdit is a program to create and edit protected encrypted documents.
It can manage TEXT, RTF and RTFD (with images) format.
It saves documents on disk always as encrypted and is the ideal solution to manage 
reserved documents with formatted text and images.
CryptoEdit is absolutely simple, powerful and secure.

CryptoEdit allows to edit document as a normal simple word processor which can 
handle text and images. All the feature available in a modern Cocoa based rich text 
processor are available in CryptoEdit.
The text can be formatted using rules, different font,style, size, color.
All the usual manipulations of fonts are available via menu and dialogs plus custom 
styles are available. Spelling in your native language. Text search is full 
implemented. 
Insertion of images inside the document with just drag and drop.
CryptoEdit can import from other documents in standard TEXT or RTF or RTFD 
(RTF + images) .
Documents can also be exported as TEXT, RTF or standard RTFD (included 
images)
CryptoEdit document are saved always encrypted for security purpose. If you saved 
it you can be sure that you saved it encrypted.
Saving a document containing images, will create on disk a single file with all the 
text and images encrypted in a single file. Any data the user puts in the document is 
encrypted and not readable without the right password.
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Getting Started with CryptoEdit

Start to Work with CryptoEdit

At launch CryptoEdit opens automatically e “Untitled” empty window.
You can use CryptoEdit exactly as a normal styled editor.
All the function available in a advanced editor are available under CryptoEdit.
You can even drag and drop images from the finder inside a document and them will 
be embedded inside

When you will go to save on disk, if a password was not defined yet for the 
document, it will ask for it (CryptoEdit saves ALWAYS encrypted).
This is the only time you have to insert the password to protect the document. The 
application will remember it every time you will want to save this document on disk.
When in future you will try to open again the document, it will ask for the password.
How it works?
CryptoEdit protects any document you save on disk.
The protection of the document it is Not based on a trick.
The protection it is not based on the application refusing to open the document if 
you don't insert the password.
The protection is based on the encryption, using the blowfish algorithm, of the entire 
content of the document.
When you open a document, if you don't provide the right password, the entire 
content of the file is an unrecognizable bunch of bits and no one, even expert 
hackers or programmers, can understand them.
There is also an important thing: if you loose the password of a document, it can't be 
opened.
Even we, the developer of CryptoEdit can't help you.
There are no backdoors or others trick. CryptoEdit is a security tool and we realized 
it as the best tool we could produce with honesty and integrity. We ensure the users 
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that there is no way to break it except breaking the blowfish encryption of the data 
inside the document.
We will repeat it again: there are no backdoors of any sort in Crypto Edit.
To decrypt the file content, you must have the password used to protect it. 

To avoid to forget the passwords used to protects your documents, we suggest to 
save the passwords used inside Password Repository, a software we produce 
useful to manage all your passwords of any kind.
Password Repository can open and decrypt a CryptoEdit document in a single step 
(if the right password is stored in Password Repository) simply clicking a button.
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CryptoEdit Reference
About CryptoEdit

CryptoEdit is an advanced RTF  and RTFD (with Images) Editor based on Cocoa, 
able also to embed images in text,  that saves documents on disk always in a 
encrypted (password protected) way
The user has no way to save the document in plain format, this to avoid to save 
reserved data in a form anyone can read by mistake. If it was saved with CryptoEdit 
is secure by default.

Only a person knowing the password used to save a CryptoEdit document, will be 
able to open and read it.

CryptoEdit is easy to use because it is similar to other word processor available on 
the Mac plus adding default encryption on anything saved on disk.

CryptoEdit uses the strong Blowfish encryption algorithm to encrypt and decrypt 
data on the fly without any appreciable delay in opening and saving documents. 

Features 

The features of CryptoEdit in editing document are:
Full text justification with use of rules with available different ruler format for any row.
Full use of fonts, styles, colors, and even of custom styles as in a full featured word 
processor and full use of the standard Font Dialog.
Full range of Find functions usable in the document.
Spelling service.
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Inclusion of images in many format, tiff, jpg, gif ... and so on, using a simple Drag 
and Drop and with a resulting file, when saved on disk, totally crypted included the 
embedded images in a single file. This is different of a standard RTFD file which 
saves the file as a bundle, with images embedded inside the bundle. This is what we 
think is the perfect solution, considering CryptoEdit is about safety of your data, and 
we assume that also the images inside your reserved documents are reserved too.

Import

To import native text, RTF and RTFD (RTF + images) inside a CryptoEdit document 
use the Import functions under the File menu. Simply select the file you want to 
import and CryptoEdit will place the content of the file at the cursor position. If you 
select something in your document, selecting Import will replace the selection with 
the content of the imported file.
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Public Note

You can have a CryptoEdit document display a public note opening it, before 
inserting the password. This is intend as a way to have a text note available to 
everyone, also people without the password to open the document. The public note 
is "public", everyone can read it just launching the document, so, do not insert 
reserved data in the public note!
The public note is not encrypted. Typically you can insert a text for you to read 
before inserting the password, or if you want to distribute your document, you can 
use the public note to explain how to obtain the password from you ... and so on.
Use the public note inside the document for the purpose you need.
Access this functionality from the menu or the standard toolbar.

Toolbar

You can use the toolbar at the top of the CryptoEdit Window to access frequented 
function.
With control-click (or right-click if you have a 2/3/n buttons mouse) you can also 
select "Customize Toolbar" and specify the icon buttons inside it in the usual 
standard way.
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Save the Document

To save a document select the “Save” command from the “File” menu.

In case a password was not yet set for the current document, CryptoEdit will ask 
you to insert a password to protect the document. After that, you will be able to save 
the document using the save panel that will be automatically presented.

The document will be saved encrypted using the password you inserted.
Successive save operations will be performed without the need to insert the 
password again, CryptoEdit will remember the password you inserted and will use it 
for the document.

Every document is associated with one password, if you have more than one 
document opened and you inserted a password for one of them, this password will 
not be used by other documents and you have to specify a password for every new 
document you want to save.
Is up to you to choose to use the same password for every document or a different 
one for each document.

CryptoEdit will ask it for every document just one time only. After that, every 
document will remember its password.
You will need to use the password again in a document only if you want to change 
the password or if you closed it and you want to open it again.

Open a Document
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To open a CryptoEdit document select “Open” from the “File” menu.
A standard Mac OS X dialog will let you select the file to open.
After that the document will need to be decrypted using the password used to save 
it.

Without the right password , the document can't be opened because data inside are 
cryptic and abstruse, not just because CryptoEdit has a lock. There is not the 
possibility to understand and present the data inside the document in a readable 
form even using others software. Plus the password is not stored inside the 
document in any way. If you provide the wrong password, the program understand is 
wrong just because the decryption session fails, not because it was compared with 
the right password, CryptoEdit doesn't know the right password until you insert it. 
The document can't be read using tricks.

Even us, Tension Software, the developer of CryptoEdit can't decrypt a saved 
document generated by CryptoEdit without the right password.
There are no backdoors in the software, we have no interest to place them, and we 
acts honestly with our customers, so with CryptoEdit you get a tool that is based on 
the power of mathematical algorithm, because this is guaranties of effectiveness. 
Tricks has not a long life as our experience suggests. Mathematical algorithms such 
as the well know Blowfish used in CryptoEdit, offers a good reliability and a strong 
protection.

You are warned, loosing or forgetting the password used to save a file with 
CryptoEdit is equal to lost the data inside the document and we can't help you in this 
unfortunate circumstance.
Use a password Manager (we suggest our Password Repository) to remember your 
passwords.

Import from File

To import data inside a CryptoEdit document, select the a import command from the 
“File” menu.
The content of the imported document will be placed at the insertion point.
If you select text inside your document the imported content will replace the selected 
text. In same way it works as the paste command.
Import can work importing Text or RTF files or RTFD files.
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The "Import as Text from File" works on text and also on RTF and RTFD files.
Everything imported will be considered a text file. 
If you import a RTF file with with "Import as Text from File"
you will insert the rtf code as if it was text.
If you want to import a RTF file and have the RTF feature enabled as in a true RTF 
editor, you must use the "Import as RTF from File…"
Using "Import as RTF from File…" allows only to select files ending in .rtf and insert 
the content directly with the RTF formatting applied.
You can also import RTFD files. RTFD files are a special kind of RTF with images 
embedded.
RTFD files are implemented as bundle with RTF and images of different format 
resulting in a single graphical page. You can import only from files ending in .rtfd 
When you import a RTFD file, CryptoEdit handle it natively and place the content as 
usually at the current prompt position. The result of the imported area is a formatted 
text and graphics as the one imported. The difference is only at saving time.
When you save a CryptoEdit file, it is saved on disk in a single encrypted file, even if 
it contains images, and not in a bundle (RTF + images) as in a RTFD files.
Well, we can say that you can work with CryptoEdit and you don't need to know that 
to use it. It is just to understand the difference on a RTFD standard file and a 
CryptoEdit file containing content imported from a RTFD file. In a plain RTFD file the 
images are separate from the text and placed inside the same bundle (which looks 
like a single doc on Mac), in CryptoEdit rtf text and images are all encrypted and 
stored in a single data file, all encrypted.
When you import data or embed images also using drag and drop, data will be 
encrypted by CryptoEdit saving the document, but what is encrypted is the 
CryptoEdit document with the data that were copied from the source to the 
document. The original data still are on your Hard Disk in plain format and they can 
be read by everyone. If you delete the source, the imported data still are inside the 
CryptoEdit document, images included, because, we will repeat it, they were copied 
inside the document, images included. 
If you don't delete the source you have the data encrypted in the CryptoEdit 
document but the original source still are on your Hard Disk in plain format.

Export to File

To export the data inside a CryptoEdit document select one of the export command 
under the File menu. 
CryptoEdit will present a standard file dialog: specify the file to export to, and 
CryptoEdit will export all the content of the document to the file in the format you 
selected.
The resulting exported file will be readable by any standard application able to red 
the exported format, text, rtf or rtfd (rtf + images)
The CryptoEdit document is not affected in any way, you only just exported in a plain 
file a content of a secure document, so this can in some way make available to 
everyone accessing the exported file, a private content. You know the content of the 
file, you exported it, you know if this is want you really want ... at this point you 
should understand what you do with your data.

Password

Understanding how passwords are used is a fundamental step for using CryptoEdit 
in the best way.
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First of all understand that every document is associated with a password. The 
document need the password to be saved on disk.
The document can't be saved for security purpose in plain format (we assume that if 
you are using CryptoEdit you are going to save reserved data).
If you forget to set a password for a document, CryptoEdit will ask for the password 
at saving time, this to prevent someone to save data unprotected.
CryptoEdit can't save unprotected document. It's a feature, not a limitation.
If you saved it, you can be sure you saved it crypted.
If you are working with a document and you didn't set a password for it yet, you can 
do it before saving using the “Password” command from the “File” menu.
The panel will ask you to insert the password two times just to be sure you are 
inserting the password you want to.
Inserting a different password of what you think, and don't see it because you are 
using the secure text field which displays dot instead of letter as you type, it is 
similar to don't know the used password , with tragic consequences for the data in 
the document (you won't be able to access the document in future). This is the 
reason you are asked to digit the password two times.
If you have a document with a password already set, you can at any time change it 
using the “Password” command from the “File” menu. To change it you must provide 
the old password and insert and confirm the new one.

If you change the password and you have written down the password in a secure 
place (as an example on a paper or using CryptoEdit) , remember to update it, or 
when you will go to read it you will read the old one, and when you will try to open 
the document with the old password you have changed ... you understand, also 
smart people sometime do silly things.
Note that the password is case sensitive, so “myhome” and “Myhome” are different 
password 
Please check that the caps lock of your keyboard is not inserted when you digit the 
password (unless you really want it) because if you think you have inserted 
“myhome” and you inserted “MYHOME” as long as you will try to open the 
document with “myhome” you will get a wrong password alert that can drive you 
crazy. We reported this specific case because we noticed that is a common error by 
users. We also noticed at that point that people try to insert the same wrong 
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password a zillion of time hoping the computer will accept it. We can insure you that 
if it is wrong, CryptoEdit won't accept it, even if you try a zillion of time.

Encryption

Encryption is a fundamental part of CryptoEdit.
With computers now part of our current life, everyone has reserved data on her/his 
Mac.
These data contains detail very very important about personal life or work.
A person simply can't afford that someone can read and maybe make public these 
data.
Your computer can be stolen, especially if it is a portable, and at that point it is just a 
matter of hours before all your data will be scanned.
You may also need technical assistance, because your computer need to be fixed 
by a technician, and you have to give it to a technical center, and you can be sure 
someone will have access to all the plain data on your hard Disk.
If you have used CryptoEdit and you have used a good password  others can do 
nothing with your data, because they are encrypted with a strong algorithm 
(Blowfish) and without the password your data are a useless series of bit, just crap. I 
can't say it is impossible to decrypt them, but the effort necessary to break Blowfish 
in the way CryptoEdit uses it, it is really too much for them.
CryptoEdit doesn't allow to save without password, if you saved it, you can be sure 
that you saved it crypted. You won't find yourself asking " Did I save it encrypted?" 
It's a feature! 
CryptoEdit asks you to use a password of a minimum of 6 character to force you to 
use a password with a minimum of security. This because 6 char is the minimum 
length for a good password. Longer (at least 9 chars or more) is better.
It would be possible also to let the software choose the password for you the first 
time, but you need a password you can remember, so you need to think yourself at 
the password to use.
Unfortunately very often this is a cause of big pain because people doing this don't 
realize they are disabling the scope of encryption, using a week password. Please 
use a good one (one other can find easily)

Using CryptoEdit as a Services from Other Applications

CryptoEdit can be used as a services from inside other applications
Under any application from the services menu, when a text is selected you can 
select the ʻNew CryptoEdit Document with Selectionʼ
CryptoEdit will create a new document containing a copy of the previously selected 
text, ready to be saved in an encrypted format.
Use this service any time you have content in various applications and you prefer to 
save it on disk only as encrypted document.
The created document, when saved on disk,  will be readable only providing the 
correct password as any CryptoEdit document. 

Preferences

CryptoEdit User Guide  © 2005-2010 Tension Software! page 12



General

Specify the action to do at startup
• New Document: creates a new document at startup
• File browser: opens the dialog to select a CryptoEdit document from disk to launch 
• None: performs nothing at startup
• Open Selected Document: allows to select a document and have it launched 

automatically at startup, this is a standard way to operate in case you use just a 
single document as the main repository of your notes or use often the same 
document.

To select a document you have 3 way: 
• Pressing the select from disk button and select it from the open dialog that will 

follow
• Dragging it from the finder or dragging it using the proxy icon (the icon in an 

opened document in the title bar)
• Editing it in the edit field by keyword (the hard way)

At any successive relaunch CryptoEdit will execute the option selected.
The additional two buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch

Edit

Settings used opening a new document:
• Ruler in the document visible
• Ceck Spelling as-you-type enabled
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Advanced

Advanced settings:
• Font used in a new opened document
• Font used to display the public note

Update

CryptoEdit can inform you if an update is available.
If enabled, the application will check no more then once a day.
ʻAsk at startupʼ asks you if you like to have the application check if an update is 
available when you start the application
ʻDisabledʼ avoids any check

When you check if an update is available, the application ping the Tension Software 
server and receive an answer about the last release available, the application can in 
that way know if its obsolete or not.
In case the application will ask you if you like to download an upgrade.
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If you download the upgrade, you need to install it.
A common error is to download an upgrade and install it maintaining the old 
application somewhere on the hard disk.
Then using to open the documents sometime the old application and sometime the 
new one. This cause some problems*. To avoid it simply install your application in 
the place dedicated to it, the Application folder. When you install an update on the 
standard Application folder, the system will ask if you want to replace the old one 
with the new, answering yes will install the new one replacing the old.

*If the application says the document you are trying to open was created with a newer 
version of the application, probably you have two different release of the application on your 
Hard Disk and you are trying to open a document with the older version after having 
modified the document with the new one. When you receive a similar message open the 
about box inside the application and see if you are running the last release. In case 
download it, install it and USE it!

Help

CryptoEdit provides a standard help menu ...maybe you already found it!
Under the help menu use the Visit Pomola.com to access our site a download the 
very last version of CryptoEdit and other software for Mac we make.

Licensing the program
You can use the command under the Help menu to access our web site 
From there you can purchase a license to use CryptoEdit using one of the payment 
service we provide. It easy, fast, and secure.
Purchasing a license remove all the limitations inside CryptoEdit

If you are evaluating to purchase this software, consider that it is realized in Cocoa 
and in Objective-C, the basis of all the last generation software for mac OS X, and 
you can expect a long life for any products based on Cocoa. Mac OS X and the 
Cocoa technology are estimated to have really really long life with continuous 
improvements (more then the life of Mac OS Classic of around 15 years) because 
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Mac OS X and Cocoa are solid technologies (Mac OS classic was just a toy if 
confronted with Mac OS X) and new features can be added without problems as the 
time request them. 
This software is Universal Binaries and runs native on both PPC Mac and Intel Mac.

If you decide to purchase a license, thank you for your support. When you see on 
the net how much quality software there is for Mac and how much software is added 
every day it is because users support small developers buying software.
 
History

CryptoEdit is a program developed in its first release in 2005 by the Tension 
Software using as a basis the Cocoa Library and Objective-C with Apple X Code 
development environment.
Cocoa is the modern, object oriented library at the core of many amazing things in 
Mac OS X and Objective-C, the language which make possible to access all the 
cool technology inside Cocoa, using an object oriented amazing dynamics 
paradigm.
As a result of this, CryptoEdit doesn't inherit any legacy problem, it's just a brand 
new application with a fast and smart interface, realized for the new and coolest OS 
of the new millennium, Mac OS X, with the very last technology available.
The Cocoa Environment and Objective-C were inherited by Apple from Next (as 
every one knows) and despite they are revisited and adjusted continuously by Apple 
engineer they are based on algorithm that now are used from years and proved to 
be rock solid and expandable (look at how many improvements was made on mac 
OS X from the first release without altering its solidity).
CryptoEdit uses the same engine we used for Password Repository, our program to 
save password encrypted, and considering Password Repository on OS X already 
proved to be a reliable solution, we are confident also CryptoEdit will prove the 
same thing when in use by Mac users around the world 
The encryption mechanism used by CryptoEdit is the famous Blowfish, well know for 
its solidity, efficiency and difficulty to crack, implemented and accessed in C and 
Objective-C to obtain record performance managing encrypted data. 

Support

You can also obtain support using the ʻSupport Email...ʼ command. An email will be 
prepared using your email client with the correct address to send to.
Yes, we answer to your emails.

CryptoEdit is a Commercial Program

You can use our software for a test period of 10 days
After that you are required to buy a license to be legally authorized to continue to 
use our software

Licensing CryptoEdit

You can buy a license to use our software using the ʻBuy Licenseʼ command under 
the Help menu.
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You will open in your browser our license web page on our web site 
From there you can buy a license to use CryptoEdit using one of the payment 
service we provide. It easy, fast, and secure and all most important form of payment 
are accepted.
We carefully selected or international reseller to be sure the buying experience for 
our customer will be as best as possible and without any problems.
After purchase you will receive from Tension Software a license email containing 
your full name and a license code
Open the License dialog with the command ʻlicenseʼ under the ʻCryptoEditʼ menu 
and insert these data in the License dialog. The software will become fully licensed 
and fully enabled for future use.

Name and license code are remembered by the program and donʼt need to be re-
inserted at successive launch.
In case you move on a new Mac you need to re-insert your name and license
The license is valid for a single Macintosh. You can purchase for two Mac as long as 
they are not used at the same time, as example a desktop and a laptop used by the 
same user.

Consideration about Licensing CryptoEdit

If you are evaluating to purchase this software, consider that it is realized using the 
Cocoa library (the native last generation library on Mac OS X) and in the Objective-
C language (the first class language development on Mac OS X)
The two technology are the basis of all the last generation software for Mac OS X, 
and you can expect a long life for any products based on Cocoa and coded in 
Objective-C.

Mac OS X and the Cocoa technology are estimated to have a really long life with 
continuous improvements (more then the life of the now ancient Mac OS Classic 
which was  around 15 years) because Mac OS X and Cocoa are solid technologies 
(Mac OS classic was just a toy if confronted with Mac OS X) and new features can 
be added without problems by Apple when they are required. 
It was not so easy with previous generation of OS.
In our opinion the Cocoa technology will live and grow for many decades from now, 
so Cocoa based software are today the best way to go if you have to select software 
to use.

If you decide to purchase a license, thank you for your support.
When you see on the net how much software there is for Mac and how much 
software is added every day, it is because users support small developers buying 
software and because the Macintosh software ecosystem itʼs really a great place to 
work due to the incredible success the Macintosh has today and the common 
feeling of the community (we use the Mac because we love doing things in a smart 
way).
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